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Warranty And Software Licence Agreement 

WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use of the 
Westdev and/or Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage media on 
which the software is recorded. Do not open the sealed package without first reading, understanding and agreeing the terms 
and conditions of this agreement. If you do not agree to the license conditions you may return the SOFTWARE for a full 
refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts supplied by 
Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby grants the Customer a 
non-exclusive license to use the LICENSED SOFTWARE on a single computer workstation. Each computer workstation, 
even on a network, must have its own separately LICENSED SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE is 
originally or subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or the 
copyright owner retains title and ownership of the LICENSED SOFTWARE recorded on the original media and all 
subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original and other copies may 
exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the subject of 
copyright. Unauthorised copying of the LICENSED SOFTWARE, including software which has been modified, merged, or 
included with other software, or of the written materials is expressly forbidden. You may be held legally responsible for 
any copyright infringement which is caused or encouraged by your failure to abide by the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is transferred 
with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this Agreement, and (iii) all 
complete or partial copies of the LICENSED SOFTWARE, including copies on data storage devices are also transferred (or  
destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, and you 
may not remove or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark notices. You must use 
all reasonable efforts to protect the LICENSED SOFTWARE, diskettes, and documentation from unauthorised use, 
reproduction, distribution or publication, or otherwise in violation of applicable law. Please contact our Customer Service 
department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED SOFTWARE and 
all complete or partial copies thereof. It will also terminate if you fail to comply with any term or condition of this 
Agreement. You agree upon such termination to destroy the LICENSED SOFTWARE and all complete or partial copies 
thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, performance, 
accuracy or suitability for any purpose. In no circumstances will the copyright holder be liable for direct, indirect, 
incidental or consequential damages resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall apply 
equally to this software except where the terms of this agreement are specifically modified by the copyright holder(s). Such 
modification(s) will be included in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of copyright. 
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Chapter 1. Getting Started 
Installation 

Installation is via the autorun setup. If you are not familiar with this process it is 
explained briefly below: 

Insert the CD-ROM into your CD-ROM drive and wait a short time. The CD-ROM will 
run up to speed and an Easy-PC Welcome screen will appear. If autorun has been disabled 
on your computer you must execute the 'setup.exe' program using the Start menu and 
Run command from the Windows task bar. 

The installation is the same for new and existing users alike. Existing users i.e. version 
V3.0 to V11.0 can install V12.0 over an existing installation without deleting the old one 
first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC For Windows - Version 12.0 option, or click then press Run. 
Following the instructions on the screen, you should use the same Destination Folder for 
the Program Files as your existing Easy-PC program files e.g. C:\Program Files\Number 
One Systems\Easy-PC 

All other instructions should be followed until completion. 

Click Finish to complete the installation. 

Running Easy-PC For Windows 12.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
you may also wish to create an Easy-PC Shortcut icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder. 
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Chapter 2. New Features in Easy-PC V12.0 
Introduction 

All features are categorised as being SCM specific, PCB specific or Both (relevant to both 
SCM and PCB designs). 

Library Structure Overhaul (Both) 

The method in which libraries are stored, organised and managed has been significantly 
changed. 

Library symbols are no longer tied to a specific library and the library mechanism can use 
multiple lookup paths from which to take library items. This means network folders as 
well as multiple local folders can now be utilised. 

Library Manager 

The Library Manager has been altered in two areas: 

A Folders tab has been added to the dialog. This is used to define the folders in which 
libraries exist and the order in which they are searched. 

 
The dialog is split into two logical areas of functionality. 

The Folders and Search Order define where the libraries exist. These can be local and 
network paths. Multiple search paths can be defined. You are no longer restricted to one 
single library path. 
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IMPORTANT The most important aspect of this area of the dialog is that the order in 
which the folder paths appear going down the list, is the order in which library items will 
be found. This is significant when adding Components to the design as this is the order in 
which the libraries will be searched. 

 
Buttons on the right side of this dialog allow the creation and editing of search paths and 
navigation to be performed. Using the Up and Down arrows on selected folder paths 
allows you to change the search order. Paths at the top of this list will be searched first. 
Where duplicate library items exist, the one found first in the search list will be used. 
Libraries within a folder are alpha-numerically sorted. 

The Delete button only deletes the search path, it does not delete the library folder. 

The second area of the Folders dialog is the Files Found area. From the folder search list, 
each of the libraries found in the paths defined are displayed here. Again, items found 
within these libraries are used in the library manager or in the Add component dialog in 
the order they appear. 

 
The Delete button here will be used to actually delete the library, so care should be taken 
using this. 

The Library Manager Folders dialog now provides a single point of control for all 
library paths within Easy-PC, Translate to PCB for example. This dialog is the only 
location you can change them. The previous Library Directory path in Settings, 
Preferences has been removed and is replaced using the Folders dialog. 

The Library Manager dialog 

In addition to the new Folders tab, each of the existing dialogs has been modified to cater 
for the expanded functionality. 
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The separate Library name path controls have been replaced with a single Library: drop 
down list. This list is based on the libraries found in the Folders search path. You can 
choose individual libraries to select items from or you can now choose [All Libraries]. 

The Library Contents: list now displays the library item found and the library name 
from which it was read only if <All Libraries> is selected. 

Checking for Duplicate Library Items 

A report is included in Easy-PC V12 for checking your existing libraries for duplicate 
items. There is no automatic method for correcting these, you must manually locate the 
duplicates and make the changes necessary. 

The Report button from each of the library manager dialogs (Schematic Symbols, PCB 
Symbols and Components), as well as listing the library contents (as it did previously), 
will also now list any duplicate items it finds when reporting all libraries. 

The master library contents supplied by Number One Systems have been checked and 
corrected for duplicates, none will now exist. If you elect not to install the supplied 
libraries, it is recommended that you run the Report to check for duplicates in your own 
libraries. 

Important: When checking for duplicate library items, be careful which item you delete. 
Be aware that schematic symbol pin number sequences will have an effect on the 
Component pin numbering and may not be consistent. Check Components carefully after 
deleting duplicates. 

LibNames.txt 

If you have been using the libnames.txt file for library ordering, this feature is now 
redundant. However, changes within new Library Manager dialog mean that you can now 
use the library search order option to force particular library folders and libraries to be 
located and used first. By moving search folders further up the list (in the Library 
Manager, Folders), these will take precedence. Files within these folders are search 
alphanumerically, renaming library files means they will be more or less significant in 
that folder. 
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Mapping of one SCM pin to multiple PCB pins (Both) 

Using the Component editor within the Library Manager, you can now map one 
Schematic symbol pin to multiple PCB footprint pins. 

This is best demonstrated with a real example. The example used here is the Fairchild 
FDC2512 part. The datasheet looks like this: 

 
The internal mapping of the PCB footprint means that pins 1, 2, 5 and 6 are common to 
the one schematic symbol pin. The schematic symbol contains 3 pins overall. 

In the Easy-PC Library Manager the mapping is done using the PCB Symbol Pad 
Number column. Use a comma character to indicate multiple PCB pin numbers. In the 
example below, the Schematic symbol pin, pin 1, is mapped to PCB footprint pins 1,2,5 
and 6. When this option is used, you must have a letter in the Component Pin 
Name/Number column for these corresponding pins. 

 
Pin Mapping and Connections 

There are two formats which can be used for denoting multiple mapped pins; you can use 
commas and the plus (+) sign. 

If a comma is used, the PCB pins will be mapped externally and Optimise will show 
connections to each of these pins. 

If a + sign is used, the connections are made internally and only the first pin in the list will 
be connected to. 
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Tabbed Dialogs & Improvements (Both) 

Technology Dialog 

Technology style dialogs on the Settings menu have been consolidated to one easy-to-use 
Technology dialog. 

 
The dialogs available in V11 and previous Easy-PC versions which have been effected 
are: Nets, Net Classes, Styles, Spacings, Values, Wires, Layer Spans, Layers and 
Layer Types. 

A new page exists for Hatch Styles and Value Names. 

Remembered Styles Dialog 

The Remembered Styles dialog is now called Defaults and contains a tabbed dialog for all 
the existing Remembered Styles.  

Existing Remembered Styles dialog options now moved are: pads, text, shapes, copper, 
vias, nets, dimensions, text callouts, flying wires, wire links, drill tables, layer stacks. 

In the PCB editor, there is also a new tab for remembered Tracks. 

 

Save Units used to create a symbol into the library (Both) 

When you use the Save to Library feature to save Symbols and footprints to the library, 
V12 now saves additional information. It now also saves the Grid, the Units and the 
Origins (Relative and System), so they may be reused if the symbol is re-edited. 
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Separate technology file settings for designs and symbols (Both) 

Default technology files for designs and symbols are now separate, this allows design 
technologies to include items (board, shapes, etc) and have colour settings (e.g. pin 
names) which need to be different to symbols. 

Slotted Pads (PCB) 

The ability to have slotted pad styles has been added to Easy-PC V12. 

From the Design Technology dialog and Pad Styles, you can create the slotted pad the 
same as you would any other pad style. 

 
When creating or editing pad styles, you can now select a Hole Shape. 

 
The shapes available to you are listed in the drop down list box. 

 
When using shapes with rounded corners, you are also able to enter the Corner: radius of 
the shape. 
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Slotted pads styles cannot be local, they must always be global and defined in the 
Technology dialog. 

Existing Designs 

Pad Styles in existing designs can be modified to include the new slotted pad style if 
required. You must create new plot types to process these new styles for manufacturing. 

Plotting & Printing O/P (Excellon) 

The Plotting & Printing dialog has been modified to enable slotted pads to be output. 
When an Excellon format file is requested, the Settings tab now has check boxes for 
Holes. You can check the Plated status required for output as well as Round Holes or 
Slotted holes. 

 
The ODB++ output has now been changed to accommodate slotted pads. Plated Slots are 
output to the special layer ‘plated slots’, along with any plated board outlines. Unplated 
slots will be added to the ‘boarddata’ layer. 

Cutouts (Both) 

Shape can now contain true cutouts. Cutouts can be added using the new Add Cutouts 
options from the Add menu. 
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To use this option, select the shape required from the Add Cutouts menu. Then select the 
shape in which to add the cutout to. Draw in the cutout and release. The cutout will be 
drawn in the shape. 

 
Cutouts can intersect with the shape edge or other existing cutouts. The effect of this is to 
remove the cutout from the shape edge. The cutout may even break the shape into several 
pieces. 

 
Add Merge 

You can add a shape to an existing shape. The resulting outline is the combination of the 
two shapes. 

Hatched/Cross Hatched Shapes (Both) 

Shapes can now be Hatched. The hatch style can be Hatch or Cross Hatch. Cross 
Hatching is a double crossed line, whereas Hatching is not crossed. The example below 
shows a Cross Hatch style. 

 



 Easy-PC For Windows V12.0 Supplement   15 

The example below shows a Hatch style. 

 
Hatch Styles 

Hatching is defined on the Settings menu and Design Technology dialog under the 
Hatch Styles tab. 

 
Angle is the angle of the hatch shape line or lines. For Cross Hatch, the second line is at 
90 degrees to the first line. 

Coverage specifies how much copper as a percentage of the shape area will be covered 
with shape. For example, 50% would be half shape coverage and half empty. 

Cross-hatched allows you to specify hatching or Cross Hatching. 

Copper Pour 

You can specify the hatch style on the copper pour dialog. Check the Hatched radio 
button to select this option. 
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Active Status bar (Both) 

A subtle change has been made to the status bar at the bottom of the Easy-PC window. By 
double clicking on the words displayed, Abs for example, you are able to change the 
appropriate setting. You can change Styles, Layers, Units, Coordinates and switch 
between Abs/Rel modes. 

 

Active PDF Writer (Both) 

Available in both the Schematic and PCB design editors, you can now opt to output your 
plots to PDF format. For this, Easy-PC has a built-in PDF writer. This can be selected 
from the Plotting & Printing dialog on the Output page. 

If installed, you can still use your own Windows PDF driver but using the mechanism 
means the PDF file is also active. You can see design information displayed within it once 
plotted. 

 
The output format of the PDF file can be tailored to suit your requirements. By selecting 
the Device Setup button, different parameters can be changed. 

When plotted, the output is now active and looks like this: 
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By hovering the mouse on a component (or net), a small dialog is displayed. From this 
you can select Component> or Attributes> and view the values for each. Attributes are 
only displayed if values have been assigned to component sin the design. 

Changes to the Plotting & Printing dialog (Both) 

The Plotting & Printing dialog has been improved to facilitate your plotting. 

Dialog Declutter 

A small change has been made to rearrange the main dialog to declutter it and ensure you 
know that the four tabs are not global for ‘all’ plots but specific to each. 

 
Pre-Plot Checks 

The pre-plot checks that are done when you click Run will now make sure that at least 
one plot has board outline enabled. This check – and the warning message you get if no 
board is selected is turned on/off by the Warn if no plots include the board outline 
checkbox on the Options dialog.  

Plots which reference layers that are empty (and hence would produce nothing if plotted) 
are automatically unchecked. 

The check box to Use all Spacings on the Plotting & Printing dialog under Options is 
now in Design Technology dialog and on Rules dialog. 
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Preview of plot 

By selecting the Plot Preview checkbox on the plotting dialog, you can now display a 
preview of the plot, plotter ‘bed’ and design extents. 

In the Preview window, the bigger red area shows the plotter bed size, this would be the 
paper size if a Windows printer or the size defined for the plot bed if Gerber. The smaller 
inner blue area is the design extents. This would include drawing borders or items outside 
the board outline if defined. The green area is the board outline. Black items within this 
are details of the plot that will get printed. This is not an exhaustive display but is 
designed to give you an idea of the plot output, not every minute detail of that plot. 

 
When using the Position dialog, changing values and using the Position buttons will have 
an instant impact on the preview. 

Shapes Improvements (Both) 

New Shapes 

Three new shapes have been added to the Add menu for Shapes and Copper: Square, 
Triangle and Single Line.  

To accommodate the line function the old Polygon and line options are renamed to Closed 
and Open Shapes. Square has been added to all other shape types, and Square & Triangle 
have been added to Add Cutout and Add Merged options. 

When adding Square, Rectangle or Circle shapes, from the context menu you can now 
select Define From Centre. Instead of the shape being added from the edge, it will now 
be added from the centre of the shape. 



 Easy-PC For Windows V12.0 Supplement   19 

When adding a Triangle shape, there is a new option available on the context menu - 
Equilateral Triangle. This is available in the last phase of adding a Triangle, i.e. once 
you have defined one side, and it forces the triangle to be an equilateral shape. 

 

Shape Editing Improvements (Both) 

A range of shape editing improvements have been made to version 12 to aid your design 
process. 

Show Diameter in Properties for arcs 

The Properties dialog now shows the Diameter for arcs or circles. 

 
Type Radius/Diameter 

When editing Mitres, Type Radius has been added to the contact menu, and, if fillet, 
Edit Diameter has been added. When the edit has been completed an online DRC check 
has been added. 

When editing Arcs, Type Radius, Type Diameter and Type Angle have been added to 
the context menu. When the edit has been completed an online DRC check has been 
added. 
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When editing Circles, Type Radius and Type Diameter have been added to the context 
menu. 

When in Select Mode, you can now select an arc segment and from the arc submenu, you 
can use Type Radius, Type Diameter and Type Angle. 

Add Corner and Delete Corner  

The Add Corner and Delete Corner options have been added for use with shapes. These 
options are available on the context menu for selected line segments. 

Item Positioning Improvements (Both) 

Show Delta Coords on Status Bar  

When moving an item in the design, the X,Y coordinates of where the item came from 
and is currently are shown on the status bar. This is displayed as the Delta coordinates dx: 
and dy: 

 
During move, you can also use the Reset Delta Coords option from the context menu to 
reset these coordinates. 

 
Type Offset and Type Coordinates 

When moving items or for selected items, you now have the general Type Coordinate 
and Type Offset commands. Additionally, in Add PCB Connection and Swap 
Connections, you have the Type Pin Name commands.  
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Typing Shape Coordinates 

When using the Type Coordinates dialog, you can type a whole shape in by typing a 
space after each coordinate instead of pressing OK. The shape segment is added and you 
are returned to the Type Coordinate dialog to continue. To finish the shape, use OK or use 
‘=’ after the last coordinate. In this mode the first two coordinates are absolute start X and 
Y, and the rest are offsets. 

When using the Type Coordinates dialog, you can also type in U1.6 (for example) as the 
‘target’ component/pad in the X coordinate box to move to the position of that pad, or 
start a track on that pad. 

Coordinate Origin Improvements (Both) 

Set Symbol Origin 

The Set Symbol Origin command has been added to the symbol editors. This is available 
on the context menu along with the existing Set Origin commands. 

 
View Origins 

You can now view the Symbol origins in the Schematic or PCB designs and change their 
colour. Colours are changed in the Display option on the Settings and Highlight dialog 
under Symbol Origins. 
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Replicate (Both) 

The Replicate option has been added to Easy-PC V12. This is the ability to duplicate an 
item and then specify the number of copies and their position. 

From a selected item, a component or shape, from the context menu, select Replicate. 

 
The Replicate dialog is displayed. 

 
From this dialog set your required parameters and click OK. 
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Rearrange Multiple Items (Both) 

A new option similar to Replicate has been added to V12. The Rearrange Multiple 
Items option allows you to select an existing collection of like items and place them into 
an array. This can be used on shapes, components, pads or Vias. 

A collection of similar items can be selected: 

 
From the context menu select Rearrange Multiple Items 

 
Change the parameters required: 
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The result will match the parameters. Where there are not enough items to satisfy the 
parameters, the option will complete it as best it can. When there are more items than the 
Number Of Items specified in the X, Y directions, in our example below if we chose 2 by 
2 say, the remaining items would be placed in the X direction. 

 
When placing components, they do not have to be same symbol, and pads do not have to 
be the same style. 

Preserve Attached Segments (Both) 

During move (Place), the new Preserve Attached Segments option is available to 
describe how unselected segments attached to moving selected segments are altered.  

 
If you leave this option unchecked, it will work as before, i.e. the attached segments are 
matched to a segment mode and altered thus. 

Select it to preserve the angle and far end point of the unselected attached segments. This 
is usually achieved by changing the length of the selected segment.  
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This is demonstrated during track editing. 

 

Place Horizontal and Vertical Segments (Both) 

During Place, two new commands Place Horizontally and Place Vertically are available 
on the context menu. Selecting one of these restricts the item movement to that direction 
only. 

These options can be added to a shortcut key or can be used from the Place context menu. 
The commands can also be used directly on a selected item (so that you don't get the jump 
to grid when it is first moved).  

 
From the context menu, select Place Horizontally or Place Vertically. 
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Another small change is the ability to use the three Place commands (Place Horizontally, 
Place Vertically, Preserve Attached Segments) with shortcut keys in select mode when 
nothing is selected. In this case it will pick select the item under the cursor. This enables 
us to use Place Horizontally etc. with a corner without getting a small move first. 

Copper Pour Keepout Areas (PCB) 

The ability to make Copper Pour areas Keepout areas have been added to PCB design. 
When you add a Copper Pour Area, you can now select the Pour Keepout check box on 
the Copper Pour Area Properties dialog. 

Copper Pour Keepout areas would normally be added inside a Copper Pour area to create 
a void in the copper. 

If the Net name is assigned to the Copper Pour Keepout Area matches the net being 
poured, then it is avoided. 
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Pour Thermal Flags (PCB) 

On the Copper Pour Areas, there are now two Thermal check boxes, Thermal Pads 
and Thermal Vias. This allows thermals to be specified separately for pads and vias. 
Previously you could only include/exclude thermals on vias, they would always be done 
on pads. 

Thermal flags are also now stored and retained on each Area, rather than being set at the 
time of Pouring. 

 

Find (Both) 

Find Filter 

You can filter found items in the list by using the filter on the Goto dialog. 

Check the Use Filter box to activate the filter. A dialog will be displayed into which you 
can type the name you wish to find. You can use standard wildcards (* and ?) in this field. 

 
Find Pad [By Terminal Name] 

The Goto list has also been expended to include the item Pad [By Terminal Name]. 
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Component Suppression Flags (Both) 

On the Component Properties, there are several new check boxes that allow you to 
suppress the component (or portions thereof) from various aspects of the program 
(plotting, parts lists, SCM to/from PCB). 

 
You also now have the ability to save and load suppression settings using simple text 
files. These are described in detail in the online help under the Index heading 
Suppressing Components. 

Measure Improvements (PCB) 

The Measure Tool has been enhanced to more comprehensive allowing you to measure 
the distance between any two items, and the distance between two selected points. It now 
gives you more size information about the selected items. 
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Add SMD Pad in PCB Symbol Editor (PCB) 

When in the PCB Symbol editor, you can now select Add SMD Pad from the menu or 
Add toolbar. This is used to add a pad which lives on the Top side of the PCB and has no 
drill hole. 

 
The defaults used for when adding this pad are taken from the new Defaults dialog on the 
SMD Pads tab. 

 

Nets Dialog sort order (Both) 

On the Nets page of the Design Technology dialog, this now sorts default 
(unnamed/auto-named) nets to the end of the list, the user-named nets appear first in the 
list. It also has a check box to show/hide auto-named (default) nets. 

DRC check min annular ring (PCB) 

The existing DRC check under Manufacturing for Min Annular Ring no longer checks 
min annular ring for unplated holes. This allows you to create bare holes without getting 
DRC error. 
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Layer Types Improvement (PCB) 

On the new Design Technology, Layer Types has been changed with the inclusion of a 
new check box for Surface Mount Free Pads. The old Pads check box has been replaced 
with the All Layer Free Pads check box. 

 

Layers Bar Categories (PCB) 

Within the Layers Bar, a ‘Categories’ on/off selections has been added. A new button 
Show>> and <<Hide, has been added. Once revealed, this provides you with a quick 
mechanism for switching on or off specific categories of display items. 
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Milling of board outlines (PCB) 

You can now output board outlines as routs in a Drill Data type of plot. There are now 
two board settings under Board on the Settings tab for this type of plot. You can choose 
to output plated or unplated outlines. The outlines will be milled with the width of the 
thickness of the board line style. If this is too small, it will use the minimum routing tool 
size defined in the NC Drill setup dialog. 

 

Values used for Hyperlinks or Hyperlink Values (Both) 

The new Value Names tab has been added to the new Design Technology dialog. From 
this, you can specify whether a Value name can be considered as a Hyperlink or not. 

 
Selecting components that have any of the above attributes will have the Execute 
Hyperlink command on the context menu. Also, free text and callouts that look like 
URL’s or filenames have the Execute Hyperlink command on the context menu. 
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Open Multiple Files at once (Both) 

From the File menu, you can now multi-select designs to open at the same time using the 
Open dialog. They are still opened in their own design editors separately. 

Multi-select files can be done using frame select, Ctrl-pick or Shift-pick. 

 

Insert Layer Stack Preview (PCB) 

Insert Layer Stack Preview 

The Layer Stack preview can now be added to the design. Use the Add Layer Stack 
command from the Add menu. Once added to the design, it can be printed or plotted as 
required. The Layer Stack preview can be added to any layer in the design, it can also be 
moved to another layer using the Change Layer command from the context menu. 

Once added to the design, if your layer stack changes, uses the Update Layer Stack 
command from the context menu to update the preview. 

You can view and change Properties of the Layer Stack Preview by selecting it in the 
design. Text Styles and Lines Styles used for the preview can be changed. 
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Default Properties of the Layer Stack preview being added can be defined in the 
Defaults dialog on the Settings menu and Layer Stack. 

 
Print Layer Stack Preview 

You can now print the Layer Stack Preview using the Print button on the dialog. 
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PCB Interaction Preferences (PCB) 

A new check box for Delete Removes Isolated Pads From Net has been added the 
Preferences dialog under PCB Interaction. 

When checked (the default setting), this does what the program has always done when 
deleting items – if after delete you end up with pads/nodes that are ‘isolated’ (not 
connected by track to anything else on the net) they are removed from the net. When 
unchecked, Delete will no longer take those pads out of the net, you would need to use the 
Remove From Net command manually if you want them disconnected. 

 

Auto Mitre Any Angle (PCB) 

From within the Auto Mitre option, you can now select the Any Angle check box. This 
enables the auto mitre option to mitre tracks with non-orthogonal angles, normally only 
90 degree corners are mitred. 
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Library Contents Improvements (Both) 

Inconsistencies have been removed from the standalone set of libraries supplied with the 
product and some items have been moved into more appropriate libraries. 

The component libraries (.cml) that have been removed are: AN3, Analogue, Bipolar1, 
Demolib, Fet1, Fet2, Layan, Opamp1 and Pulsar. 
The Symbol libraries (.ssl) that have been removed are: Demolib and Layan. 

The PCB Symbol libraries (.psl) that have been removed are: Demolib and Layan. 

The library Transistr has been renamed to Transistor. 

Other Library Changes 

Connector.cml - was Conn_std. Some connectors have also been moved from 
Discrete.cml 

Opamps.cml – now contains Opamp1, and op-amps from Analogue.cml 

Transistor.cml - was Trnsistr and now contains previous component libraries Bipolar1, 
FET1, FET2, and transistors from Analogue.cml 
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